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Executive Overview 
Oracle WebCenter Spaces is a pre-built, pre-integrated, and highly customizable 

WebCenter application. As you begin using WebCenter Spaces you may find there are 

some aspects that you want to modify or extend beyond the customization capabilities 

provided in WebCenter Spaces. For example, you may want to add custom functionality, 

such as custom Java code, additional task flows, and so on. 

To support advanced requirements, Oracle provides a sample JDeveloper workspace 

and several sample projects to help illustrate the customization process. This document 

describes the workspaces, the samples, and how to build and deploy WebCenter Spaces 

shared libraries that contain your custom code. 

Introduction 
SampleWebCenterSpacesExtensions is a sample workspace in which you can develop 

extensions, and build and deploy WebCenter Spaces shared libraries that contain your 

custom code.  

Oracle recommends that you copy the sample workspace and use this as a starting point 

for building WebCenter Spaces extensions of your own. Within your own workspace 

version, you can review and deploy the samples, delete the samples, import future 

samples, and most importantly, add extension projects of your own.  The current sample 

set shows you how to: 

 Deploy custom Java code ï Develop custom session invalidation code and make it 

available in WebCenter Spaces.  

 Customize user profile attributes ï Customize the default user attributes derived 

from the user profile store, and add custom attributes of your own.  

 Search custom profile attributes - Deploy a custom Oracle SES crawler that 

searches custom profile attributes. 

 Create rule-based resources ï Change the skin based on custom logic. 

 Deploy custom task flows - Develop specialized task flows in JDeveloper and make 

them available to WebCenter Spaces users. 

 Customize the Login task flow ï Configure the default Login task flow to 

authenticate users against Oracle Access Manager SSO. 
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Deploying and Undeploying Sample WebCenter Spaces 
Extensions 

This section describes: 

o Downloading and exploring the WebCenter Spaces extension samples 

o Building and deploying a custom WebCenter Spaces shared library (.WAR) 

o Reverting to a previous custom WebCenter Spaces shared library version 

Overview 

To extend or customize WebCenter Spaces you must download a sample JDeveloper workspace, 

add your customizations, and then deploy a shared library that contains your custom code. You 

must also download the WebCenter Spaces development workspace so you can register the name 

of your custom shared library in the WebCenter Spaces shared library dependency list and redeploy the 

updated list (in extend.spaces.webapp ). The following diagram illustrates the process. 
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This whitepaper describes how to build and deploy custom WebCenter Spaces shared libraries 

that contain custom code (highlighted in red boxes). For instruction how to update and redeploy 

the WebCenter Spaces shared library dependency list, refer to "Extending WebCenter Spaces 

Using JDeveloper" in Developerõs Guide for Oracle WebCenter (11.1.1.5) available at: 

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e10148/jpsdg_wcsres.htm  

Downloading, Copying, and Exploring the WebCenter Spaces Sample Workspace 

Sample WebCenter Spaces extensions are available from Oracle Technology Network. 

1. Before you start:  

a) Ensure WebCenter Spaces is installed, configured, and working as expected. 

b) Download and install Oracle JDeveloper 11g (11.1.1.5.0). Available from: 

http://www.oracle.com/technetwork/developer-tools/jdev/downloads/index.html  

c) Download and install Oracle JDeveloper WebCenter Framework and Services 

Design Time Extensions 11.1.1.5.0 (oracle.webcenter.framework_bundle.zip). 

Tip:  You can install extensions from JDeveloperõs Help menu. Select Help> Check 

for Updates. 

2. Download SampleWebCenterSpacesExtensions.zip from Oracle Technology Network: 

http://download.oracle.com/otndocs/tech/webcenter/files/SampleWebCenterSpacesExte

nsions_ps4.zip  

This download includes a JDeveloper workspace, several sample extension projects, and 

other resources you might need to support your extensions.  

3. Unzip the content locally. 

The .ZIP file contains the following files and folders:  

\SampleWebCenterSpacesExtensions  

SampleWebCenterSpacesExtensions.jws  Use this workspace to review samples, develop extensions, as well as build 

and deploy shared libraries that contain your custom code. 

\JavaCodeAndSessionTimeout Project containing Java code that customizes the default session timeout. 

\OAMLogin Project that redirects the default Login task flow to Oracle Access Manager 

single sign-on. 

\ProfileAttributes  Project containing code that overrides default profile attributes and enables 

you to extend user profiles by adding your own attributes. 

\ProfileCrawler Project containing an Oracle SES crawler that searches custom user profile 

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e10148/jpsdg_wcsres.htm
http://www.oracle.com/technetwork/developer-tools/jdev/downloads/index.html
http://download.oracle.com/otndocs/tech/webcenter/files/SampleWebCenterSpacesExtensions_ps4.zip
http://download.oracle.com/otndocs/tech/webcenter/files/SampleWebCenterSpacesExtensions_ps4.zip
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attributes. 

\RuleBasedResources  Project containing a custom class that determines which skin to use based on 

the óorganizationô to which the current user belongs (). 

\SampleTaskFlows  Project containing a custom task flow that displays a list of pages in a bulleted 

list. 

\WebCenterSpacesSharedLibExtension  A customizable WebCenter Spaces project that generates an application-level 

shared library (WAR file) containing your custom code.  

  \WCAppEARSharedLibExtension Project that generates an application-level shared library (EAR file) 

containing custom code. (Only required for the profile crawler project). 

\SourceFiles  Out-of-the-box content for you to edit/customize.  

\langs Default resource bundles for all languages 

\resourcebundles  Required JDeveloper directory 

\src  Required JDeveloper directory 

 

4. Make a copy of the sample workspace in which to develop your extensions: 

a) Rename the folder SampleWebCenterSpacesExtensions.  

For example, AcmeWebCenterSpacesExtensions. 

b) Rename the workspace SampleWebCenterSpacesExtensions.jws.   

For example, AcmeWebCenterSpacesExtensions.jws. 

c) Open the following files and replace òSampleWebCenterSpacesExtensionsó with 

your new name ò<new_name>WebCenterSpacesExtensions.jwsó 

 config.properties 

 WebCenterSpacesSharedLibExtension/build.properties 

For example, replace òSampleWebCenterSpacesExtensionsó with 

òAcmeWebCenterSpacesExtensionsó. 

d) Save the changes. 

5. Open your copy of SampleWebCenterSpacesExtensions.jws in JDeveloper 

This is the workspace that you will use to review the samples, develop WebCenter Spaces 

extensions, as well as build and deploy shared libraries that contain your custom code.  
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The following projects display in the Application Navigator: 

 WebCenterSpacesSharedLibExtension - generates a customized shared library 

WAR file for WebCenter Spaces.  

You can include all the samples in this WAR file or exclude samples that you do not 

want by editing the WebCenterSpacesSharedLibExtension deployment profile. 

You can also add new projects of your own. 

The name of the shared library WAR file is customizable through the 

customer.library.name  property in config.properties. For details, see the 

next section Setting Build and Deployment Options (config.properties). 

 Five sample projects: 

 JavaCodeAndSesionTimeout  - Project containing Java code that 

customizes the default session timeout. 

 OAMLogin   - Project that redirects the default Login task flow to Oracle 

Access Manager single sign-on. 

 ProfileAttributes - Project containing code that overrides default profile 

attributes and enables you to extend user profiles by adding your own 

attributes. 

 RuleBasedResources - Project containing a sample class that determines 

which skin to use based on the 'organization' to which the current user 

belongs (UserSkinBean.java). 

 SampleTaskFlows - Project containing a sample task flow that displays a 

list of pages in a bulleted list. 

Note: The ProfileCrawler project is not displayed by default. If you want to deploy a 

custom profile attribute crawler, refer to the section "Adding a Crawler for Custom Profile 

Attributes". 
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6. (Optional) Modify the WAR file deployment profile.  

All five sample projects are included in the custom WebCenter Spaces shared library 

WAR file. If you do not want to deploy all the samples, you can edit the deployment 

profile and select only the projects you want. 

Note: If you want to deploy the ProfileCrawler project, read the section 

òAdding a Crawler for Custom Profile Attributes". 

a) In the Application Navigator, right-click the 

WebCenterSpacesSharedLibExtension project and choose Project Properties. 

b) Select Deployment, highlight custom_webcenter_spaces_war, and then click 

Edit .  

c) Select Library Dependencies. 

By default, all five sample projects are included in the custom WebCenter Spaces 

shared library (WAR file): 

 

If you want to exclude one or more samples you must edit the library dependency 

list (see next step). 

d) (Optional) Exclude JARs associated with unwanted sample projects.  

For example, only select Custom.webcenter.spaces.sampletaskflows.jar and 

Custom.webcenter.spaces.customJavaCode.jar to include these projects. 



Oracle White PaperðUsing WebCenter Spaces Sample Extensions (11.1.1.5.0)  

 

8 

 

Notes:  

 If you choose not to deploy the JavaCodeAndSessionTimeout project, you must 

comment out the <servlet>  and <servlet - mapping>  entries for the session 

invalidation servlet in web.xml located at: WebCenterSpacesShareLibExtension\ Web 

Content\ WEB-INF 

 Custom_webcenter_spaces_properties.jar is provided for backward compatibility. You 

can ignore this JAR if you are customizing WebCenter Spaces for the first time. 

The next section describes how to set options that enable you to deploy your custom shared 

library WAR file to a WebCenter Spaces managed server. 

Setting Build and Deployment Options (config.properties) 

Before building and deploying shared library extensions to the WebCenter Spaces managed 

server you must provide some information about your environment and your WebCenter Spaces 

installation.  

Use the configuration file  to configure build and deployment 

properties for your custom shared library:  

1. Open your copy of SampleWebCenterSpacesExtensions.jws.  

2. Expand WebCenterSpacesSharedLibExtension, and open the Resources folder. 

3. Open config.properties.  

4. Enter information about your JDeveloper environment and WebCenter Spaces installation 

as shown in the table. 
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 describes each property and offers examples. The defaults 

provided are only samples and must be replaced with your installation-specific values. 

PROPERTY NAME DESCRIPTION 

jdeveloper.install.home.directory  Base directory where JDeveloper is installed.  

The directory you specify contains other folders such as jdeveloper, 

wlserver_10.3, modules, and so on. 

wlst.executable Name of the WLST executable file. 

Either  (on Windows) or   (on Linux). 

extending.spaces.home.dir Path to your copy of the SampleWebCenterSpacesExtensions project.  

For example, <path>AcmeWebCenterSpacesExtensions 

oracle.jdeveloper.ojdeploy.path  Path to . (Windows) or ojdeploy  (Linux). 

wls.port Port number on which the WebLogic Administration Console is 

running. 

wls.host Host machine on which WebCenter Spaces is running and where the 

custom WebCenter Spaces shared library is to be deployed. 

wls.userkey  Name and location of the file storing administrator passwords.  

config.properties describes how to generate the file using WLST. The 

file can be copied to any suitable, accessible location. 

wls.userconfig  Name and location of the file storing administrator user details. 

 describes how to generate the file using 

WLST. The file can be copied to any suitable, accessible location. 

wls.target  Targets on which the WebCenter Spaces shared library is to be 

deployed. 

wls.webcenter.app.target  Targets on which the  file is to be deployed. 

webcenter.app.name Name of the WebCenter Spaces application. 

customer.library.name Name for your custom shared library WAR file. 

For example:  

customer.ear.library.name Name for your custom shared library EAR file. 

For example: 

(Only required if you deploy the ProfileCrawler project). 

customer.name Company name or identifier. 

restart.implementation. 

version.suffix  

Controls incremental implementation version numbers for the custom 

shared library WAR file. 

restart.implementation. 

version.suffix.ear 

Controls incremental implementation version numbers for the custom 

shared library EAR file. 

(Only required if you are using the profile crawler). 

 

5. Save your updates to . 
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Building and Deploying a Custom Shared Library for WebCenter Spaces 

After setting up a deployment profile for the WebCenterSpacesSharedLibExtension project 

and configuring config.properties, you can build and deploy your custom WebCenter Spaces 

shared library WAR file: 

1. Open your copy of SampleWebCenterSpacesExtensions.jws.  

2. In the Application Navigator, select WebCenterSpacesSharedLibExtension. 

3. To build a new version of the WebCenter Spaces shared library WAR, open the Run Ant 

 dropdown menu, and then select clean-stage: 

 

This generates a new version of the shared library WAR file. The implementation version 

number associated with the new .WAR is saved to 

<UnzipDir>/<Your>WebCenterSpacesExtensions/W ebCenterSpacesS

haredLibExtension/META - INF/MANIFEST.MF . 

4. To deploy the custom WebCenter Spaces shared library, open the Run Ant  dropdown 

menu, and then select deploy-shared-lib : 
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A new version of the shared library is deployed. To verify the new deployment, login to the 

WLS Administration Console, navigate to the Deployment Overview page, and check the 

implementation version displayed. For example, if you set the 

customer.library.name  property (in config.properties ) to 

com.acme.webcenter.spaces , navigate to Deployments> 

com.acme.webcenter.spaces>Overview.  

WebCenter Spaces only uses the latest shared library version. If you go through several 

"change-build-deploy-test" iterations, incremental versions are retained by default. You can 

use the WLS Administration Console to remove unwanted shared library versions. For 

details, see "Reverting to a Previous Shared Library Version" in Developerõs Guide for Oracle 

WebCenter. 

If the latest version is not active, see "Troubleshooting Shared Library Deployment" in 

Developerõs Guide for Oracle WebCenter. 

5. Include the name of your custom shared library WAR file in WebCenter Spaceõs shared 

library list. 

For detailed steps, refer to òRebuilding the WebCenter Spaces Shared Library Listó in 

Developerõs Guide for Oracle WebCenter. 

Note: In the latest version of DesignWebCenterSpaces.jws, use the Run Ant  dropdown 

menu to build and deploy the shared library list. 

&  Developerõs Guide for Oracle WebCenter (11.1.1.5) is available from Oracle Technology Network:  

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e10148/jpsdg_wcsres.htm 

Removing WebCenter Spaces Extensions 

You can revert to the out-of-the-box WebCenter Spaces deployment at any time. For details, see 

"Reverting to a Previous Shared Library Version" in Developerõs Guide for Oracle WebCenter. 

Removing OAM Login Button Customizations in MDS 

If you deployed the sample OAM Login code, an additional step is required to delete the login 

button customization document in MDS. Use the WLST command deleteMetadata  as 

follows: 

1. Navigate to your WebCenter Oracle home directory and invoke the WLST script:  

 (UNIX)      WC_ORACLE_HOME/common/bin/wlst.sh  

 (Windows) WC_ORACLE_HOME\ common\ bin \ wlst.cmd  

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e10148/jpsdg_wcsres.htm
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2. Connect to the Administration Server for Oracle WebCenter. For example: 

connect(username='weblogic', password='mypassword', 

url='myhost.example.com:7001')  

3. Delete the MDS customization document LoginFormView.jsff.xml : 

deleteMetadata(application='webcenter', server='WC_Spaces' , 

docs='/oracle/webcenter/webcenterapp/view/taskflows/securit

y/mdssys/cust/site/webcenter/LoginFormView.jsff.xml')  

Remove other changes relating to the OAMLogin project: 

1. In setDomainEnv.sh , remove EXTRA_JAVA_PROPERTIES: 

EXTRA_JAVA_PROPERTIES  ñ- Doracle.web center.spaces.osso=trueò 

export EXTRA_JAVA_PROPERTIES  

2.  Remove OBACCESS_INSTALL_DIR: 

OBACCESS_INSTALL_DIR="<Path to Access Server SDK Install 

Dir>/AccessServerSDK"  

export OBACCESS_INSTALL_DIR  

3. Remove jobaccess.jar  from the CLASSPATH: 

if [ "${POST_CLASSPATH}"  != "" ] ; then  

POST_CLASSPATH="${COMMON_COMPONENTS_HOME}/modules/oracle.jrf_11.1.1/j

rf.jar${CLASSPATHSEP}${OBACCESS_INSTALL_DIR}/oblix/lib/ jobaccess.jar $

{CLASSPATHSEP}${POST_CLASSPATH}"  

export POST_CLASSPATH  

else     

POST_CLASSPATH="${COMMON_COMPONENTS_HOME}/modules/oracle.jrf_11.1.1/j

rf.jar${CLASSPATHSEP}${OBACCESS_INSTALL_DIR}/oblix/lib/ jobaccess.jar "  

export POST_CLASSPATH  

4. Remove the LD_LIBRARY_PATH setting: 

LD_LIBRARY_PATH="${OBACCESS_INSTALL_DIR}/oblix/lib:${WL_HOME}/server/

native/linux/i686${CLASS PATHSEP}${LD_LIBRARY_PATH}"  

export LD_LIBRARY_PATH  

5. In commEnv.sh , remove the WEBLOGIC_CLASSPATH entry for 

webcenter_oam.jar : 



Oracle White PaperðUsing WebCenter Spaces Sample Extensions (11.1.1.5.0)  

 

13 

WEBLOGIC_CLASSPATH="${WEBLOGIC_CLASSPATH}${CLASSPATHSEP}/scratch/netp

oint/webcenter_oam.jar"  

export WEBLOGIC_CLASSPATH 

6. In WebLogic Server Administration Console, navigate to Home > Startup and Shutdown 

Classes and delete the startup and shutdown classes (OAMConfigShutdown and 

OAMConfigStartup). 

7. Remove SSO configuration for WebCenter Spaces (if required). 

For detail, see Administratorõs Guide for Oracle WebCenter. Available from Oracle Technology 

Network:   

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e12405/wcadm_securit

y_sso.htm  

8. Restart the domain. 

 

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e12405/wcadm_security_sso.htm
http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e12405/wcadm_security_sso.htm
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Sample ï Customizing the Session Timeout 
If you want to implement some behavior in WebCenter Spaces that requires the use of custom 

logic, you must deploy the custom Java code to a WebCenter Spaces shared library. The 

SampleWebCenterSpacesExtensions workspace includes a sample project to illustrate Java code 

deployment-- JavaCodeAndSessionTimeout. 

The sample contains several files: 

 SessionTimeoutPhaseListener.java  - injects JavaScript into the browser 

causing the session to timeout ônõ seconds earlier than the default setting (45 minutes). In the 

sample, n is 300 seconds (or 5 minutes) reducing the session timeout to 40 minutes.  

 SessionInvalidationServlet.java  - invalidates the user session after the 

period specified in SessionTimeoutPhaseListener.java (40 minutes) and then navigates to a 

specified HTML page. By default, the page specified is: 

/webcenter/custom/webcenter/spaces/SessionExpired.html   

 SessionExpired.html  ð informs users that their WebCenter Spaces session has 

expired and provides a link to redirect users to the login page. 

 web.xml  ð includes the custom servlet and associated mappings:  

<servlet>  

<! --  invalidates the WebCenter Spaces session based on code in the 

JavaCodeAndSessionTimeout project -- >  

 <servle t - name>SessionInvalidationServlet </servlet - name> 

 <servlet -

class>custom.webcenter.spaces.view.SessionInvalidationServlet</servlet - class>  

</servlet>  

<servlet - mapping>  

 <servlet - name>SessionInvalidationServlet</servlet - name> 

 <url - pattern>/sessioninvalidatio n</url - pattern>  

</servlet - mapping>  

The web.xml  file containing the servlet reference is located at: 

WebCenterSpacesSharedLibExtension \ Web Content \ WEB- INF  

The following steps describe how to deploy the custom Java code to the WebCenter Spaces 

shared library using the SampleWebCenterSpacesExtension workspace:  

1. Open your copy of SampleWebCenterSpacesExtensions.jws in JDeveloper. 

2. Navigate to JavaCodeAndSessionTimeout\ Application 

Sources\ custom.webcenter.spaces\ view 
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3. Customize the session timeout period, if required: 

a) Open SessionTimeoutPhaseListener.java. 

b) Specify a value for secondsBefore. 

The sample value is 300 seconds (5 minutes) and this produces a 40-minute session 

timeout, that is, the session times out 5 minutes earlier than the default session timeout 

configured in web.xml  (45 minutes). 

// time in seconds before (the value in web.xml) to expire the session  

        int secondsBefore = 300 ;  // 300 se conds equals 5 minutes  

        if (secsTimeout > 0)  

4. Customize the HTML page displayed to users when their session expires, if required. 

The default page is shown here: 
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a) Open SessionExpired.html.  

Located at: JavaCodeAndSessionTimeout \ Web 

Content \ custom \ webcenter \ spaces  

b) Edit the HTML as required. 

5. Alternatively, redirect users to a different HTML page: 

a) Open SessionTimeoutPhaseListener.java. 

b) Edit the default value for sendRedirect. 

 // if required change SessionExpired.html to your own html page.  

response.sendRedirect(" /webcenter/custom/webcenter/spaces/SessionExpired.h

tml");  

c) Ensure that the new HTML file is available at the location specified. 

6. Ensure that the JavaCodeAndSessionTimeout project JAR file is selected in the 

deployment profile: 

 

7. Deploy the custom Java code. 

For details, see section Building and Deploying a Custom WebCenter Spaces Shared Library. 

8. If WebCenter Spaces implements single sign-on, ensure that the single sign-on component, 

for example Oracle Access Manager (OAM), uses the same session timeout, that is, 40 

minutes in the sample provided. 

&   For details, see òConfiguring Session Timeoutó in the Oracle Access Manager Identity and 

Common Administration Guide. Available from Oracle Technology Network at: 

http://download.oracle.com/docs/cd/E12530_01/oam.1014/b32419/idconfig.htm  

http://download.oracle.com/docs/cd/E12530_01/oam.1014/b32419/idconfig.htm


Oracle White PaperðUsing WebCenter Spaces Sample Extensions (11.1.1.5.0)  

 

17 

9. Login to WebCenter Spaces, and verify that the customized code is available and working as 

expected. 

Leave the browser idle for the time specified (the sample timeout is 40 minutes), and then 

verify that the session expires and the correct redirect page displays. 

Sample - Customizing User Profiles 

In WebCenter Spaces, the ôprofileõ feature provides a variety of views into your own and other 

users' personal profile information. User profiles include information such as your mail address, 

phone number, office location, department, manager, direct reports, and so on. Most profile 

attributes are stored and read from the WebCenter Spaces LDAP identity store; there are three 

exceptions--the profile photo, status message, and expertise. 

The ProfileAttributes project in the SampleWebCenterSpacesExtensions workspace 

demonstrates different ways to customize the default user profile attribute set. For example, you 

can:  

 Override the default profile attributes 

 Add custom profile attributes of your own 

 Override the default profile page 

Overriding the Default Profile Attributes 

The ProfileAttributes project includes CustomProfileImpl.java , a sample Java class that 

overrides a default attribute source, and configures people - profile - config.xml  to 

point to the new class.  

The sample Java class shows how to override two default LDAP attributes (Department and 

Photo) as follows: 

o Department ð replace with the hard coded string Sales Department as follows:  

public String getDepartment()  

     throws ProfileException  

     {r eturn "Sales Department";}  

o Photo - replace user photos with images in an alternative store (file system in this case) 

Important considerations: 

 Performance: When implementing custom logic to fetch values from a database, 

remember that the JDBC call executes each time any profile is accessed. WebCenter 

Spaces does not cache profile data. Keep this in mind when coding your custom class to 

minimize any impact on performance. 
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 Search: Profile attribute searches are always against the configured identity store. This is 

still the case even if you customize an attribute source. 

For more information, see òDeploying the Sample ProfileAttributes Projectó. 

Adding Custom Profile Attributes 

The ProfileAttributes project also includes ExtendedProfileAttribes.java , a sample 

Java class that enables you to include additional profile attributes. The sample includes two 

additional attributes: 

 Project 

 SIP Address 

After deploying ExtendedProfileAttribes.java  you can reference profile attributes 

defined in the file in WebCenter Spaces using EL such as: 

#{wcProfileCustomAttribute['smith'].sip }  

If you add your own profile attributes to Exten dedProfileAttribes.java  you can 

reference them in the same way. For more information, see òDeploying the Sample 

ProfileAttributes Projectó. 

Overriding the Default Profile Page 

The ProfileAttributes project includes Custom View.jspx , a sample profile page to replace 

the default profile page supplied with WebCenter Spaces. For more information, see òDeploying 

a Custom Profile Pageó. 

Deploying the Sample ProfileAttributes Project ï Customize or Add Profile Attributes 

The following steps, describe how to customize or add attributes displayed in WebCenter Spaces 

user profiles using the SampleWebCenterSpacesExtension workspace:  

1. Open your copy of SampleWebCenterSpacesExtensions.jws in JDeveloper. 

2. To override default profile attributes: 

a) To review the sample class, navigate to ProfileAttributes> Application Sources> 

custom.webcenter.spaces> CustomProfileImpl.java  

You can use JDeveloper to implement a customized profile implementation class of 

your own. If you do, you can specify any valid name for your custom class and package 

name. 

Tip : Use Ctrl+Space  to view/add all the attribute implementation methods that are 

available, using JDeveloperõs Code Completion Insight functionality shown below: 
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b) Open ProfileAttributes\ Application 

Sources\ custom.oracle.webcenter\ peopleconnections\ profile\ metadata\ people

-profile-config.xml: 
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c) Use the user - obj - impl  setting to point to the custom class. 

The sample specifies CustomProfileImp.java . Any valid class name and 

package name is acceptable here. 

 

Notes:  

o Do not change anything else in this file.  

o Only reference one implementation class from the people - profile -

config.xml  file. 

o Do not rename the package containing people - profile - config.xml  or 

modify the structure in any way. 

3. To add profile attributes: 

a. To review the sample class, navigate to ProfileAttributes> Application Sources> 

custom.webcenter.spaces> ExtendedProfileAttributes.java 

You can add your own profile attributes to the file or deploy the sample attributes 

(Project and SIP Address).  
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b. Add a getter (and setter if you need to save) for additional profile attributes, as required. 

4. If you want to deploy the sample or your own extensions, ensure that the ProfileAttributes 

project JAR is selected in the deployment profile: 

  

5. Deploy the custom profile attribute class. 

For details, see section Building and Deploying a Custom WebCenter Spaces Shared Library. 
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6. Login to WebCenter Spaces, and open your profile to verify that the customized attributes 

display. 

If you deployed the samples provided: 

a. Verify the following: 

o Department ð Displays ôSales Departmentõ 

o Photo ð   

o monty.png displays when logged in with the user name Monty 

o pat.png displays when logged in with the user name Pat 

o a default shadow image displays if an alternative image is not available for the 

logged in user 

If new images do not display, click the Refresh link to clear cached data. 

 

b. Use EL to reference the new profile attributes Project and SIP Address. 

To do this you must first expose each new attribute as a component in the resource 

catalog as follows: 

i) Navigate to the Resource Catalog design tab 

(Administration>Resources>Resource Catalogs).  
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ii) Create a new resource catalog, if required. 

iii) Edit the resource catalog, and then choose Add>Component. 

iv) Name the component, for example Project Attribute.  

v) Add the appropriate XML, for example, add the following snippet for the ôProjectõ 

component.  

<af:panelLabelAndMessag e 

xmlns:af="http://xmlns.oracle.com/adf/faces/rich" 

label="Project " labelStyle="font - weight:bold;" id="#">  

<af:inputText 

value="#{ wcProfileCustomAttribute [(pageFlowScope.userId == 

null ? securityContext.userName : 

pageFlowScope.userId)]. project }" simple=" true" columns="40" 

maximumLength="50" shortDesc=" Enter project details " 

id="#"/>  

</af:panelLabelAndMessage>  

 

vi) Create a similar component for the SIP Address attribute, that is, repeat steps iii ð

v, changing the wcProfileCustomAttribute EL to reference ôSipõ and enter an 

appropriate description. 

vii) If you have not done so already, configure pages to use the updated resource 

catalog. Do one of the following:  
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 If  you want to add the new profile attributes to system pages or business role pages, 

navigate to WebCenter Administration 

(Administration>Configuration>General), and ensure Resource Catalog 

for Business Role Pages specifies the resource catalog that contains your 

profile attributes. 

 If you want to add the new profile attributes to pages in the Home Space, navigate 

to WebCenter Administration (Administration>Configuration>General), 

and ensure Resource Catalog for Home Space specifies the resource catalog 

that contains your profile attributes. 

 If you want to add the new profile attributes to pages in a particular Space, 

navigate to Space administration (Space Settings>General), and ensure 

Resource Catalog for Pages specifies the resource catalog that contains your 

profile attributes. 

viii) Navigate to the profile page (Administration >Pages>System Pages) or any 

other page in which you want to add the new profile attributes. 

ix) Click Edit Page to open the page in Oracle Composer. 

x) Add the profile attribute to a page or task flow: 

 To add the profile attribute to a page, click Add Content, and then select 

the profile attribute you require from the resource catalog. For example, 

select Project Attribute. 

 To add the profile attribute to a task flow, select the task flow, click 

View>Source, click the task flow to Edit it, and then select the profile 

attribute you require from the resource catalog. 

c. Alternatively, upload pre-customized user profile ôAboutõ pages directly to WebCenter 

Spaces that already include EL references to the new sample attributes Project and SIP 

Address. Two pre-customized About pages are provided with the sample: 

 viewemployee.jsff.xml - About page customizations for view mode; 

display two new attributes Project and SIP Address. 

 editemployee.jsff.xml  ð About page customizations for edit mode; 

display the Project attribute so users can edit this value. 

Use WLST to upload the customized About page samples to WebCenter Spaces as 

follows: 

i) Navigate to your WebCenter Oracle home directory and invoke the WLST script:  
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 (UNIX)      WC_ORACLE_HOME/common/bin/wlst.sh  

 (Windows) WC_ORACLE_HOME\ common\ bin \ wlst.cmd  

ii) Connect to the Administration Server for Oracle WebCenter. For example: 

connect(username='weblogic', password='mypassword', 

url='myhost.example.com:7001')  

iii) Upload About page customizations: 

importMetadata(application='webcenter', 

server='WC_Spaces', 

fromLocation='<sampleziplocation>ProfileAttributes/m

ds/, 

docs='/oracle/webcenter/peopleconnections/profile/vi

ew/jsf/regions/ootbviews/mdssys/cust/site/webcenter/

viewempl oyee.jsff.xml ' )  

importMetadata(application='webcenter', 

server='WC_Spaces', 

fromLocation='<sampleziplocation>ProfileAttributes/m

ds/, 

docs='/oracle/webcenter/peopleconnections/profile/vi

ew/jsf/regions/ootbedit/mdssys/cust/site/webcenter/ e

ditemployee.jsff.xm l ')  

iv) Login to WebCenter Spaces. 

v) Open your user profile and click About to access your full profile details 

(viewemployee.jsff.xml ). 

The new Project and SIP Address attributes display. For example: 
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vi) Click Edit  to see the About page in edit-mode (editemployee.jsff.xml ). 

The new Project attribute displays. For example: 
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Deploying a Custom Profile Page 

The following steps, describe how to deploy a custom profile page (CustomView.jspx) using the 

SampleWebCenterSpacesExtension workspace:  

1. Open your copy of SampleWebCenterSpacesExtensions.jws in JDeveloper. 

2. Navigate to: ProfileAttributes> Web Content> 

custom>webcenter>spaces>profile>CustomView.jspx 

 

3. Review or modify the sample page CustomView.jspx. 

4. Configure WebCenter Spaces to use the new profile page. 

Modify the table WC_PPL_COMMON_SETTING  as described in steps b i and ii below. 

The SETTING_KEY column uses: 

 spaces - settings.galleryPage.pathForSelf  to specify the profile 

page displayed for the currently logged in user  

 spaces - settings.galleryPage.pathForOthers  to specify the 

profile page displayed for any other user. 

a. Log in to SQLPlus as DBA or another administrative user to the WebCenter database. 

b. Execute the following commands: 
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INSERT INTO WC_PPL_COMMON_SETTING (ID, APPLICATION_ID, SCOPE_ID, 

SERVICE_ID, USER_ID, TASKFLOW_INST_ID, SETTING_KEY, SETTING_V ALUE) 

VALUES ('98457a7d - 72df - 4e92 - 9396 - 9a63b7f414e7', 'webcenter', 

'defaultScope', 'oracle.webcenter.peopleconnections.profile', 

'SYSTEM', 'SITE', 'spaces - settings.galleryPage.pathForSelf' , 

' /custom/webcenter/spaces/profile/CustomView.jspx' );  

INSERT INTO WC_PPL_COMMON_SETTING (ID, APPLICATION_ID, SCOPE_ID, 

SERVICE_ID, USER_ID, TASKFLOW_INST_ID, SETTING_KEY, SETTING_VALUE) 

VALUES ('98457a7d - 72df - 4e95 - 9396 - 9a63b7f414e7', 'webcenter', 

'defaultScope', 'oracle.webcenter.peopleconnections.profile', 

'SYSTEM', 'SIT E', 'spaces - settings.galleryPage.pathForOthers' , 

'/custom/webcenter/spaces/profile/CustomView.jspx' );  

Note: If these rows already exist, update each SETTING_VALUE column to: 

/custom/webcenter/spaces/profile/CustomView.jspx 

5. Hide the out-of-the-box òMy Profileó business role page from everyone: 

a. Use the WLST command exportMetadata  to export pages.xml  from MDS. 

Export the file configured for users with the anonymous - role  and the 

authenticated - role  as follows: 

exportMetadata(application='webcenter',server='WC_Sp aces',toLocati

on='/scratch/mymdsdump',   

docs='/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296

c916a23ed/role/anonymous - role/pages.xml')  

exportMetadata(application='webcenter',server='WC_Spaces',toLocati

on='/scratch/mymdsdump',          

docs='/ oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296

c916a23ed/role/authenticated - role/pages.xml')  

b. Open each pages.xml  file in a text editor, locate the business role page 

MyProfileMainView , and specify hidden=" true " : 

<! --  Business Role Pages -- > 

<pageDef  

id="Page_2eb852ac_10f5902cb2f__7f10"  

contentMRef="/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_b

eee_296c916a23ed/businessRolePages/MyProfileMainView.jspx"  

shared="true"  

hidden="true" />  

c. Upload updates to both pages.xml back to the MDS as follows: 
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importMetadata(application='webcenter',server='WC_Spaces',fromLoca

tion='/scratch/mymdsdump',docs='/oracle/webcenter/page/scopedMD/s8

bba98ff_4cbb_40b8_beee_296c916a23ed/role/anonymous -

role/pages.xml')  

importMetadata(application='webcenter',server='WC_S paces',fromLoca

tion='/scratch/mymdsdump',docs='/oracle/webcenter/page/scopedMD/s8

bba98ff_4cbb_40b8_beee_296c916a23ed/role/authenticated -

role/pages.xml')  

6. To deploy the sample page or your own profile page, ensure that the ProfileAttributes 

project JAR is selected in the deployment profile: 

  

7. Deploy the custom profile page. 

For details, see section Building and Deploying a Custom WebCenter Spaces Shared Library. 

8. Login to WebCenter Spaces, and then open someoneõs profile to verify that the custom page 

displays. 

Click your user name, View Profile Gallery, Go to Profile, or the name of another user to 

display the new profile page.  
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If you deployed the sample, the text òCustom Profile Page for: <user name>ó displays:  

 

 

To revert to the original profile page 

1. Log in to SQLPlus as DBA or another administrative user to the WebCenter database. 

2. Execute the following commands: 

del ete from WC_PPL_COMMON_SETTING where SETTING_KEY = 'spaces -

settings.galleryPage.pathForSelf' ;  

delete from WC_PPL_COMMON_SETTING where SETTING_KEY = 'spaces -

settings.galleryPage.pathForOthers';  

3. If you updated the row (by deleting and then inserting updated values), restart the 

WebCenter Spaces managed server. 
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Sample ï Adding a Crawler for Custom Profile Attributes 

User profile attributes that you add through the ProfileAttributes project are not automatically 

searchable in WebCenter Spaces. If you are using Oracle Secure Enterprise Search (Oracle SES) 

to search WebCenter Spaces, you can deploy a custom crawler implementation that searches your 

additional profile attributes. 

The ProfileCrawler project provides a sample profile attribute crawler that you can use: 

 ExtendedProfileAttributesCrawler.java  and 

ExtendedProfileServiceCrawlerQueryResult.java ð contain custom code to crawl custom 

profile attributes and populate Oracle SES with the data 

 service-definition.xml  ð defines the name of the sample crawler class: 

<search - crawlable - definition 

id="oracle.webcenter.peopleconnections.profile.custom"  

        xmlns="http://xmlns.oracle.com/webcenter/search"  

        version="11.1.1.0.0"  

        scoped="false">  

    <crawlable - class>  

          custom.webcenter.spaces.Ex tendedProfileAttributesCrawler  

    </crawlable - class>  

 </search - crawlable - definition>  

If you write you own crawler class, you can change the name here. 

 CustomProfileDataSource.java ð enables access to custom profile attribute data. The 

sample hard codes data for sample custom profile attributes SIP Address/Project, for a 

single user named ôweblogicõ as follows:  

public static Map<String, Map<String, String>> 

getCustomAttributesMap ()  

  { return new HashMap<String, Map<String, String>>()  

    { { put(" weblogi c", new HashMap<String, String>()  

        { { put(" SIPAddress ", "weblogic's SIP address");  

            put(" Project ", "weblogic's  project");}         

}); }}; }  

When you define additional profile attributes of your own, you must replace this with code 

that fetches your custom profile attribute data from your data source. 
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The ProfileCrawler project does not display in JDeveloper by default. Follow the instructions 

below  

1. If you have not done so already, configure WebCenter Spaces to use Oracle SES. 

This includes setting up crawl sources for WebCenter Spaces in Oracle SES, and then 

configuring WebCenter Spaces to use Oracle SES. For detailed steps, refer to òConfiguring 

Oracle SES to Search WebCenter Spaces Applicationsó in Administratorõs Guide for Oracle 

WebCenter. 

&  Administratorõs Guide for Oracle WebCenter is available from Oracle Technology Network:   

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e12405/wcadm_search

.htm#WCADM9801  

2. Enable shared library EAR file deployment for the custom profile crawler project. 

Unlike other sample projects, custom code generated from the ProfileCrawler project must 

be packaged in an application-level shared library (rather than a webapp-level shared library) 

and therefore, you require a project that generates an application-level shared library (EAR 

file). Such a project (WCAppEarSharedLib Extension ) is provided with the sample 

but it is hidden by default. Follow these steps to expose both 

WCAppEarSharedLib Extension  and the sample ProfileCrawler  project:  

i) Ensure that your copy of SampleWebCenterSpacesExtensions  is not open in 

JDeveloper.  

ii) In a text editor, such as Notepad, open your copy of 

SampleWebCenterSp acesExtensions.jws . 

iii) Uncomment the ProfileCrawler  project entry. 

Change: 

<! -- hash><url n="URL" 

path=" ProfileCrawler/ProfileCrawler.jpr "/></hash -- > 

To: 

<hash><url n="URL" 

path=" ProfileCrawler/ProfileCrawler.jpr "/></hash>  

iv) Uncomment the WCAppEarSharedLib Extension  project entry. 

Change: 

<! -- hash><url n="URL" 

path="WCAppEar SharedLib Extension /WCAppEarSharedLib E

xtensio n.jpr"/></hash -- > 

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e12405/wcadm_search.htm#WCADM9801
http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e12405/wcadm_search.htm#WCADM9801
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To: 

<hash><url n="URL" 

path="WCAppEar SharedL ib Extension /WCAppEarSharedLib E

xtension .jpr"/></hash>  

v) Open your copy of SampleWebCenterSpacesExte nsions  in JDeveloper to 

verify that the ProfileCrawler project displays, as well as the project that generates the 

EAR-level shared library ( WCAppEarSharedLibExtension): 

 

3. Set deployment options for the EAR-level shared library that will contain the custom 

Oracle SES crawler code. 

i) Open your copy of SampleWebCenterSpacesExtensions.jws.  

ii) Expand WebCenterSpacesSharedLibExtension and open the Resources folder. 

iii) Specify the following EAR deployment options in config.properties (located under the 

WebCenterSpacesSharedLibExtension\ Resources folder): 

PROPERTY NAME DESCRIPTION 

customer.ear.library.name  Name for your custom shared library EAR file. 

For example: 

restart.implementation. 

version.suffix.ear 

Controls incremental implementation version numbers for the custom 

shared library EAR file. 

(Only required if you are using the profile crawler). 

iv) Save your updates to . 

4. Build and deploy the custom Oracle SES crawler code: 

a) In the Application Navigator, select WCAppEarSharedLibExtension. 
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b) To build the WebCenter Spaces shared library EAR, open the Run Ant  dropdown 

menu, and then select clean-stage: 

 

This generates a new version of the shared library EAR file. The implementation 

version number associated with the new .EAR is saved to 

<UnzipDir>/<Your>WebC enterSpacesExtensions/WebCenterSpace

sSharedLibExtension/META - INF/EAR/MANIFEST.MF . 

c) To deploy the custom WebCenter Spaces shared library EAR, open the Run Ant  

dropdown menu, and then select deploy-shared-lib : 

 

A new version of the shared library EAR is deployed. 

d) Open the WLS Administration Console, navigate to the Deployment Overview page, 

and check that new versions of custom.webcenter.spaces.fwk  and <your 

company>.webcenter.spaces.fwk  are deployed and active. 
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5. Include the name of your application-level shared library EAR file in WebCenter Spaceõs 

shared library list. 

a) Down load the required WebCenter Spaces development workspace from Oracle 

Technology Network (DesignWebCenterSpaces.jws ) and include some 

required files as described in steps 4 through 7 in "Downloading a Workspace for 

WebCenter Spaces Development" in Developerõs Guide for Oracle WebCenter (11.1.1.5) for 

details, see: 

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e10148/jpsdg_wcs

res.htm#JPSDG10089   

b) Enable application-level shared library list deployment: 

i. Ensure that your copy of DesignWebCenterSpaces.jws  is not open in 

JDeveloper.  

ii. In a text editor, such as Notepad, open DesignWebCenterSpaces.jws . 

iii. Uncomment the WCAppEarExtensionLibrary project entry. 

Change: 

<! -- hash><url n="URL" 

path=" WCAppEarExtensionLibrary/WCAppEarExtensionLibrary.jpr

"/></hash -- > 

To: 

<hash><url n="URL" 

path=" WCAppEarExtensionLibrary/WCAppEarExtensionLibrary.jpr

"/></hash>  

iv. Save the changes. 

c) Edit the application-level EAR shared library list: 

i. Open DesignWebCenterSpaces.jws in JDeveloper. 

ii. Expand the WCAppEarExtensionLibrary project. 

iii. Navigate to weblogic - application.xml , under Application 

Sources\ WebCenterSpacesExtensionLibrary\ public_html\ WEB-INF . 

iv. Add a <library - ref>  entry for the application-level EAR shared library 

that contains the ProfileCrawler code. 

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e10148/jpsdg_wcsres.htm#JPSDG10089
http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e10148/jpsdg_wcsres.htm#JPSDG10089
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 For example, include the library entry: 

<library - ref>  

 <library - name> 

     com.mycompanyname. custom.webcenter.spaces.fwk  

  </library - name> 

</ library - ref>  

Note: Ensure that the shared library EAR file that you reference is deployed 

on the WebCenter Spaces managed server. 

d) Set build and deployment options for custom.webcenter.spaces.fwk.ear  

which will include your updates to the application-level EAR shared library list: 

i. Open config.properties (located under the 

WebCenterSpacesExtensionLibrary project). 

ii. Enter information about your JDeveloper environment and WebCenter Spaces 

installation.  

For more information on each property, see " Configuring config.propertiesó 

in Developerõs Guide for Oracle WebCenter (11.1.1.5) available at: 

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e10148/jp

sdg_wcsres.htm#JPSDG10101 

iii. Save your updates to config.properties. 

e) Build and deploy your updates to the application-level shared library list in 

custom.webcenter.spaces.fwk.ear . 

i. In the Application Navigator, select WCAppEarExtensionLibrary. 

ii. To build a new version of custom.webcenter.spaces.fwk.ear , 

open the Run Ant  dropdown menu, and then select clean-stage: 

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e10148/jpsdg_wcsres.htm#JPSDG10101
http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e10148/jpsdg_wcsres.htm#JPSDG10101
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iii. To deploy the customized WebCenter Spaces shared library list, open the Run 

Ant  dropdown menu, and then select deploy-shared-lib . 

A new version of the shared library list is deployed to the WebCenter Spaces managed 

server. To verify the new deployment, login to the WLS Administration Console, 

navigate to the deployment overview page, and check the implementation version, that 

is, navigate to: 

Deployments> custom.webcenter.spaces.fwk>Overview 

6. Initiate or schedule a full crawl through Oracle SES administration (that includes the 

custom profile attributes). 

&   Refer to òAdditional Oracle SES Configurationó in the Administratorõs Guide for Oracle 

WebCenter for information. Available from Oracle Technology Network at:  

http://download.oracle.com/docs/cd/E21764_01/webcenter.1111/e12405/wcadm_searc

h.htm#WCADM6569  

After a full crawl, custom profile attribute data is returned in WebCenter Spaces searches. 












































